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The ColorSpace Sign Composer 
 

 

 
 

 

 
 

Overview 

 

 ColorSpace is used to create messages which can be displayed on Electronic Message 

Centers. 

 It can create messages that display text, images, video, or even the current time and 

temperature.
1
 

 Transition effects can be added to grab attention. 

 Layers allow content to be overlapped, repositioned, and resized. 

 

 

                                                 
1
 Temperature display requires a supporting EMC and temperature sensor. 
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Startup 

 

 
 

 When ColorSpace starts, it creates a default message with two layers as shown above. 

o The top layer is a Text Layer without text.   

o The second layer is a black Color Fill layer.  It is drawn behind the text layer. 

 A layer must be selected to change its settings.  By default the Text Layer is selected.  

Layers can be selected by clicking on them. 

o When a layer is selected it is drawn with a lighter color. 

 Text can be added to the message by typing in the Message Text Box. 
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Basic Text Controls 

 

 Any text entered into the Message Text box will appear simultaneously in the Message 

Viewer 

 The Font can be selected in the Message Font list box. 

 

 
 

 The size of the text can be changed in the Points list box. 

 

 

 

 The style can be changed to normal, italic, bold, or both.  
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Outline and Shadow Enhancements 

 

 
 

 Checking the Outline or Shadow options will produce the effects shown below. 

Outline 

 

 
 

Shadow 

 

 
 

  



ColorSpace 2.0 R3 May 15, 2015 Page 7 

Text Colors 

 

 
 

 The Color buttons change the color of various parts of the text. 

Note:  These colors only affect the text in the currently selected layer. 

 The “Text Color” Color button changes the color of the text. 

 The “Background” Color button changes the Fill color of the last layer. 

 The “Outline” Color button changes the color of the Outline text enhancement. 

o Note: this can only be changed when the Outline check box is selected. 

 The “Shadow” Color button changes the color of the Shadow text enhancement.  

o Note: this can only be changed when the Shadow check box is selected. 

 

Text Alignment 

 

 
 

 Text can be aligned to the left, right, top, or bottom edges of the sign by selecting a 

combination of the Text Alignment buttons: 
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Color Selection 

 

 Clicking any color button inside of ColorSpace will cause a color picking dialog to 

appear.   

 The dialog is the same for Text colors and Background Fills. 

 Monochrome (Single Color) signs. 

 

    
 

o Monochrome sign color shades are provided in 10% increments from 0% (Black) 

to 100%.  

o Select a color by clicking on the desired color box. 

o For any other value, select the ‘Custom’ square, then move the slider control to 

set the required brightness.  

o The ‘Try Color’ button temporarily changes a text or background color on the 

main screen without closing the dialog. It then restores the original color when it 

is released. Click the ‘Set Color’ button to make the change permanent. 
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 RGB Signs (Full color). 

  

 
 

o This dialog provides a list of predefined colors. 

o Select a color by clicking on the desired color box. 

o Custom colors can be added using the User Defined color in the bottom left corner. 

 

 

 

o Choosing a color from the User Defined drop down box will put that color into the 

User Defined Box. 
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o Click the “Edit Color List” button to add colors to the drop down box.  

 

 

o The desired color can be chosen using the red, green, and blue sliders. 

o The ‘Darken’ and ‘Lighten’ buttons will adjust the brightness of the color. 

o The Insert button adds the color into the User Define Color list and saves it for later 

use. 

o Clicking on a color in the list enables the Modify, Delete, and Rename buttons. 

o The Modify Selected button changes a color in the list. 

o The Delete Selected button deletes a color from the list. 

o The Rename Selected button renames a color in the list. 
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Spacing Controls 

 

 
 

 The character and line spacing can be adjusted using the track bars pictured above.   

 These controls allow text to be stretched or compressed.   

 

 
 

 If the text does not fit onto the sign, it can be compressed by reducing both line and 

character spacing to their minimum values. 
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Scrolling Ticker Messages 

 

 
 

 Checking this box causes a single text line to scroll across  

the display area.  

 Note that the Load Effects and Exit Effects are disabled when 

Ticker is checked. 

 The speed of the ticker can be adjusted by right clicking on the 

green bar for the layer and choosing “Ticker Timing”.  

 

 

 

 Adjust the slider to change the ticker speed. 

 

 

 

 

 

 

  

Right Click here to 

change the speed of 

the ticker text. 
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Text Effects 

 

 Message Text Layers can have transition effects added to grab a viewer’s attention. 

 Load Effects are shown at the beginning of the layer. 

 Exit Effects are shown at the end of the layer. 

 To change or add an effect to a Message Text layer.  Change the “Load Effect” or  “Exit 

Effect” dropdown box. 

 ColorSpace will change a portion of the green layer box yellow to indicate a load effect, 

and red to indicate an exit effect. 

 The length of the effect can be changed by dragging the edges of the yellow or red box. 
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Message Layers 

 

 
 

 There are four types of layers 

o Message Text 

 Displays static text and tickers. 

o Background 

 Displays solid colors, gradients, images, and video. 

o Decoration 

 Displays shapes and decorations 

o Time/Temperature 

 Displays time and temperature. 

 Layers allow content such as text or images to be overlapped, moved, and resized. 

 They also control when content begins, ends, and how long it is displayed. 

 ColorSpace draws green bars at the bottom of the window to represent each layer. 

o It also draws the number of frames and the display time of the layer in seconds. 

 Multiple layers of any type can be added to a message. 

 To move a layer click and drag its green bar until the start is in the desired position. 

o This will change when the layer is displayed in the message. 

 To change the length or play time of a layer click and drag the ends of its green bar. 
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Creating or Deleting Layers 

 To add a new layer or delete a layer, click the “Layer” menu at the top of the screen, or 

right click on one of the green bars at the bottom of the screen. 

                                      

 The following menu will appear. 

 

 Choosing Delete Layer will delete the currently selected layer. 

o The selected layer is indicated by a lighter green color. 

 Choosing Create Layer will display the following window. 

                               

 Choose the layer type, and click OK. 

o The starting location and alignment can also be changed here. 

  

Click the “Layer” menu 

Right click on a green 

layer bar. 

OR 
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 The “Link To” option allows the start of a layer to be linked to the layer directly 

beneath it. 

 This makes it easier to move the start of layers that should be shown at the same 

time or in succession. 
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Layer Windows 

 

 The boundary of a layer’s content is defined by its Layer Window.  

 By default this window is the same size as the sign 

 It can be resized and moved around to move the text, image, video, etc. 

 Effects such as sliding or spinning are limited to the Layer Window. 

 To show the Layer Window boundary, click the Show Layer Windows toolbar button. 

 

 
 

 A bright yellow box is drawn around the Layer Window 

 To resize a layer, first select it by clicking its green bar at the bottom of the screen. 

 Then using the mouse, drag the edges of the Layer Window to resize it. 

 Dragging the center of the Layer Window will move it.  
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 Multiple layers can be combined together to produce results like the following. 
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Background Layers 

 Background can display solid colors, gradients, images, and video. 

 To change a background layer, 

o First click on its green bar at the bottom of the screen to select it. 

o The background tab will be enabled on the right side of the screen. 

              

 You can also add a new background layer using the “Layer” menu.  See section Creating 

or Deleting Layers on page 15. 

 Now choose one of the four tabs. 

o Solid Color 

o Gradient 

o Image 

o Video 

 Load, Show, and Exit effects can be added to the background layer by changing the 

three drop down boxes at the top. 

 

Solid Color Fill 

 In the “Solid Color” Tab, Click the “Set Fill Color” button. 

 This will open a color picking dialog where the background color can be chosen. 

o See Color Selection on page 8 

 

  

Left click here 

to select the 

layer 
The background 

tab will be 

enabled. 
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Gradient-Fill Background 

 Instead of a solid color, a background layer can be filled with a blend of colors using the 

Gradient Fill dialog.  

 In the “Gradient” Tab, Click the “Set Gradient” button. 

 

 The Gradient Fill dialog will appear 

 

 Up to four colors may be set in the color selection boxes.  

 If only one color is selected, it will be blended with Black. 

 Selecting two or more colors adds each one to the blended background in the order 

selected.  

 Setting any selection box to ‘No Color’ removes it from the blended color sequence. 

 Changing the ‘Repeat’ slider value causes the color sequence to appear multiple times.  

 

 The ‘Rotate’ slider changes angle of the gradient. 

 

Repeat Rotate 
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Image-Fill Background 

 

 The image tab allows images to be displayed on a background layer. 

 To load an image, click the “File” Button. 

 A file dialog will appear.  Navigate to an image and click “Open”. 
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 The image will be drawn in the black preview area as shown below. 

 

 The black and white rectangle represents the portion of the image that will be shown on 

the sign. 

 It can be moved or resized using the mouse. 

 By default it keeps the width to height ratio of the sign (its aspect ratio). 

 The image can be stretched or compressed by unchecking the “Lock Selection Shape” 

checkbox. 

 Click the “Set Image” button to put the image on the selected background layer. 

 “Try Image” will temporarily show the image on the background layer while the left 

mouse button is pressed. 
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Video Fill Background 

 
 

 The video tab allows videos to be displayed on a background layer. 

 To load a video, click the “File” Button. 

 A file dialog will appear.  Navigate to an image and click “Open”. 
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 A preview of the video will display in the black box below. 

                          

 The black and white rectangle represents the portion of the video that will be shown on 

the sign. 

 It can be moved or resized using the mouse. 

 By default it keeps the width to height ratio of the sign (its aspect ratio). 

 The video can be stretched or compressed by unchecking the “Lock Selection Shape” 

checkbox. 

 The Start Frame and End frames can be changed if only a part of the video should show 

on the sign. 

 Click the “Set Video” button to put the video on the selected background layer.  

 

  

Play/Pause 

Preview 

Stop 

Preview 
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Select / Delete Controls 

Open / Filled Circle 

Open / Filled Ellipse 

Open / Filled Square 

Open / Filled Rectangle 

Rounded Rectangle 

Oriented Straight Line 

(Right click Line button 

to select line orientation) 

Decoration Layers 

 

 The Decoration layer type allows basic geometric shapes such as lines, squares, and 

circles to be placed anywhere in the sign window, to be used as borders, underlining, or 

to create simple cartoon effects.  

 In addition, images (such as product images or logos) can be imported from disk and 

arranged within the sign window. These can be single-frame images (such as BMP, GIF, 

JPG, or ICO files) or animated GIF sequences. 

 Use the ‘Layer / Create Layer’ menu to add a new Decoration layer to the Sign Message. 

o See Page 15, Creating or Deleting Layers 

 

 To add a Shape object to the 

Decoration Layer, first select a Shape 

button with the mouse. (The selected 

button’s background will change to 

light blue.) Now move the + mouse 

cursor to any location within the Sign 

Window and click once to create the 

shape object. 

 

 Each shape is contained within a 

bounding box used to control its size, 

proportions, and location.  

 

 Before creating a Line you must select 

its orientation (horizontal, left 

diagonal, vertical, or right diagonal) by 

selecting an option from the right-click 

dropdown list. This determines how 

the line will be drawn within its 

Bounding Box. 
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Using Shape Objects 

 

Once a basic Shape object has been placed in the Sign Window, it can be moved, resized, or re-

proportioned by dragging the entire object or any of its Bounding Box handles, and further 

customized with the Line Width and Color controls on the Shape control panel. 

 

         
 

Click on any Shape object to expose its Bounding Box handles. Drag its corner handles to 

change the size while retaining the same height / width proportions. To stretch the object taller 

or wider, use the center handles at the top, bottom, or sides. Note: Square and Circle objects will 

always retain their original proportion – they cannot be stretched. 

 

To move the currently selected object, hover the cursor within the bounding box until it changes 

to a four-pointed cross shape. Then click and drag the object to its new location. 

 

While an object is selected, use the Line Width drop-down box to change its pixel width, or the 

‘Select Color’ button to choose a new color from the standard Color Selection box. 

 

To delete an object, select it with the mouse, then click the Delete (red “X”) button. 

(Remember that any change can be reversed using the Edit / Undo or Ctrl-Z option.) 

 

The orientation of a Line object is determined by which Bounding Box handles are connected. 

You must select this orientation before placing a Line object in the Sign Window. Right-click 

on the Line button and select an option from the drop-down list. Then re-select the Line button, 

move the + cursor to any Sign Window location, and click to create the new Line object. It will 

look like one of the first four illustrations below. 

 

                                 
 

You can now stretch, thicken, or change the color of the Line using the Shape control panel. 

Adjust the angle of a diagonal line by changing the shape of its Bounding Box. 
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Creating Image Objects 

 

The Decoration layer can also display bitmapped 

images imported from disk, or pasted from the 

Windows Clipboard. Disk image files of type BMP, 

GIF, ICO, or JPG can be imported. The Paste 

button will fetch any image previously copied to 

the Clipboard from another source, such as a Web 

page. 

 

If an animated (multi-frame) GIF file is imported 

from disk, the last three lines of the Image control 

will be enabled (otherwise these will be grayed 

out.) There are 3 ways to use a multi-frame image: 

 Repeat the frame sequence continuously 

 Show each frame, but stop at the last one 

 Display a single frame as a still image 

Selecting the second option enables the Play button. 

Press it to play the animation one time; it will stop 

on the last frame with the Play button locked down. 

Click it again to release it and return to the first 

frame. 

 

 

Select the Single Frame option to enable the drop-down list next to it. Then select a frame from 

this list to be placed on the Decoration layer. 

 

Some images have a transparent background, represented in the display window by a checkered 

pattern. This prevents the rectangular image background from appearing in the Sign Window 

and obscuring elements behind it. If the background is opaque (as in the image above) you can 

change it by checking the ‘Make...Transparent’ box. This will work only if the background is a 

single, solid color, and that color includes the pixel at the lower left corner of the image. Also, if 

the background color appears within the picture part of the image, that picture area will be 

rendered transparent also. 
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Using Image Objects 

 

After loading an image and pre-selecting the desired option settings, click on the ‘Image 

button’, then position the + mouse cursor over the correct location within the Sign Window and 

click. The image will be drawn using a default size. Resize and reposition it as necessary by 

dragging the image and/or handles as described in the Shapes section. 

 

   
 

 

In this final example, the “steam” graphic synchronizes with the running sign’s timeline. 
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Time or Temperature Display 

 

 To add a time or temperature display to the sign 

 

 At the bottom of ColorSpace, right click a green layer. Then choose “Create Layer”. 

 

 

 The “Create New Layer” dialog is shown.  Choose Time/Temperature and choose Ok. 
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 Now a “Time/Temperature” layer is 

created.   

 By default it will show 12 hour time with 

no AM or PM. 

 “Font Size” changes the size of the time 

or temperature display. 

 “Time/Temp” allows different formats to 

be chosen. 

 “Text Color” changes the color of the display text. 

 “Outline” toggles the display text outline, which can increase contrast.  Change the color of 

the outline by clicking the “Color” button to the right. 

 “Flash Colon”: If checked time displays will flash the colon every second.  Uncheck this to 

disable the flashing of the colon. 

 Alignment:  Adjusts the horizontal or vertical alignment of the time/temperature display. 

 

  

12:00 12 hour time, no am/pm indicator 

12:00 AM 12 hour time with AM and PM indicators 

24:00 24 hour time 

70° (F) Temperature in degrees Fahrenheit, does not show an F 

70° F Temperature in degrees Fahrenheit, shows an F 

20° C Temperature in degrees Celsius, shows a C 
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Portable Message Files 

 

 To send the currently displayed Sign Message to another ColorSpace user, select menu 

option File / Export / As Portable Zip File.  This brings up a small dialog box: 

 

 
 

 

 Click the ‘Export’ button to combine all message components (XML, and Resource 

files) into a single Zip file with the same name as the Sign Message.   

 This file will be placed in a ‘My Documents’ subfolder called ColorSpace. 

 The ‘Open Export Folder’ button will display the contents of this folder 

 The file can be dragged to another location or dropped into an outgoing email message 

as an attachment. 

 Received Portable Messages can be extracted and placed in the local program’s Sign 

Message collection using the File / Import Portable File menu option.  

 However the easiest way to accomplish the same thing is to drag the Zip file (from a 

disk location or as a received email attachment) and drop it anywhere on top of 

ColorSpace. 
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o This will automatically extract the received Sign Message. An Import dialog 

similar to the one above will appear; press the ‘Close’ button to accept and 

extract the message. 

Sign Profiles (Initial Sign Parameters) 

 

 

 When ColorSpace is started for the first time, it will prompt for the default sign 

information.  This is called the “Sign Profile”. 

 A Sign Profile describes the LED color and dimensions (horizontal & vertical) of a 

physical sign.  

 Enter the color, width, height, and tile type of the Electronic Message Center. 

 When a new Sign Message is created, it will be based on the properties of the currently 

selected Sign Profile.   

 Profile information is saved with a Sign Message, so if a Message is loaded that was 

created using a different Profile than the current program default, the loaded Sign 

Message’s original Profile will temporarily override the default. 

 To change or add other Sign Profiles, Navigate to Edit->Sign Profiles. This will display 

the following window which allows the editing and creating Sign Profiles. 
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Scheduling Sign Messages 
 

 Before a message can be displayed on a sign, it must be scheduled. 

 First “Export” the message to the scheduler program. 

o To do this click on the blue arrow in the toolbar. 

 

                                 
 

 

 You can now start the Scheduler program by clicking the calendar ‘Launch Scheduler’ 

button on the toolbar.  

 

                     
 

  

Export to 

Scheduler 

Launch 

Scheduler 
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The Scheduler Program 
 

 
 

 Each Sign Message previously exported by ColorSpace to the Scheduler appears in the 

Message Files list.  

 The checkbox next to each message name indicates whether it is active, meaning that the 

message will transmitted, along with any scheduling information, to the EMC controller. 

 Unchecked messages will not be transmitted or displayed. Click on the ‘Active’ button 

to display only Active messages in this list. 

 Each Sign Message is associated with at least one Schedule page which determines 

whether that message will be included in the EMC display cycle, at any particular time 

of a given day.  

 This Schedule can restrict message play to specific days of the week and/or a range of 

calendar dates. The default is “no date restrictions” and the message will be displayed 

every day indefinitely, or until removed from the Active list. 

 For each day a message is scheduled to run, up to four time limits can be specified, so 

that the message will run only during these intervals. If no time limits are specified, the 

message will run each time it comes up in the EMC’s queue throughout the day. 

 When setting a time limit, the first step sets start time.  Stop time will default to 12AM.  

Click it from the list to change to desired stop time. 

 



ColorSpace 2.0 R3 May 15, 2015 Page 35 

Multiple Schedule Pages 

 

This example restricts the associated message to three time limits: 

9am – 11am, 1pm – 4pm, and 6pm – 10pm on each Monday, 

Wednesday, and Friday from Nov 15
th

 until (but not on) Dec 25. 

(Note that the second part of a date or time period is considered a 

“stop” value, and is not included in the message display interval.) 

Click on any underlined field to select or unselect a weekday, or 

to select a value from the clock and calendar dialogs. 

 

You can add additional schedule tab pages to any message, so that 

the message will be displayed at any given time allowed by any of 

its associated schedules. 

 

 

Here a second schedule has been added to the one above (using 

the Schedules / Add New Page menu option). This one allows the 

message to run at any time of day (since no time limits were 

defined) each Saturday and Sunday from December 1 up until 

(but not including) the 25
th

. All message display instances 

resulting from this schedule are in addition to those initiated by 

Schedule 1 above. 

 

 

 

 

Use the message list’s Schedule View tab to display a graphic 

overview of all scheduling information relating to the selected 

Sign Message. 
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Sequencer 

 

The ‘Sequencer’ tab has a list of messages that are in the other lists and in the same order.  

However you can re-sequence this new list by dragging and dropping message names to a new 

position. 

 

When you drag a message item and drop it on top of another one, the dragged message will be 

moved from its original location and appear just before the “drop” item target.  To move a 

message to the end of the sequence, drop it anywhere below the current last item.  If you hold 

down the ‘CTRL’ key while doing this, the “dragged” message will remain in its original 

location and a duplicate copy will be inserted before the drop target.  Duplicate message items 

are indicated with a “+” icon at the left.  This allows the user to schedule some messages to play 

more than once during a single cycle repetition.  To delete a duplicate item, select it on the list 

and press the ‘Delete’ key. 
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Sending Messages to the EMC Sign 
 

 
 

 To send the scheduled messages to the sign, click the “SEND FILES TO SIGN” button 

at the top of the Scheduler program. 

 

 The “Sign Updater” program 

will start. 

 

 A list of the files to be sent is 

shown on the left 

 

 Click Send and wait for the 

messages to be sent to the 

sign. 


